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CySBML Tutorial v1.2 
CySBML is a Cytoscape plugin for the import and work with SBML files in Cytoscape providing 
access to SBML annotations within the network context. 

The main features are 

 Java™ based SBML parser for Cytoscape using the library JSBML 
 Simple access to SBML models and SBML annotations via  BioModels.org and MIRIAM 

web services 
 Supports all versions of SBML (currently L1V1 through L3V1) 
 Support of SBML Layout package 
 Support of SBML Qualitative Models package 
 Provides SBML validation (SBML warnings and errors accessible) 
 Creates standard network layout based on the SBML species/reaction model 
 Provides access to RDF-based annotation information within the network context 
 Navigation menu based on the SBML structure linked to layout and annotation 

information 
 Successfully tested with all SBML.org and BioModels.net test cases (sbml-test-cases-

2.0.2, BioModels_Database-r21-sbml_files) 

The latest version of CySBML is available at http://sourceforge.net/projects/cysbml/. 
CySBML information is available at 

http://www.charite.de/sysbio/people/koenig/software/cysbml/. 

Please try and report any problems you encounter using CySBML to matthias.koenig@charite.de 
or to the CySBML mailing list cysbml‐team@lists.sourceforge.net. 
 

CySBML was developed by Matthias König in cooperation with Andreas Dräger  from the Center of 
Bioinformatics Tuebingen (ZBIT) and was funded by the Virtual Liver Network. 

We thank Camille Laibe for implementing additional BioModels web service functionality, the Qual 
Team as well as Finja Büchel, Florian Mittag, and Nicolas Rodriguez (Qual implementation in 
JSBML), Sebastian Fröhlich and Clemens Wrzodek (Layout support in JSBML) as well as Sonia 
Villegas, Michael Weidlich and Christian Bölling for testing CySBML. 

Thanks and have fun 

The CySBML team. 

Overview 

The tutorial gives an introduction in the work with CySBML covering, installation, main features 
and the programmatic interaction with CySBML. 
 
 1. CySBML Installation & Basic Settings 
 2. CySBML Interface 
 3. Import of SBML Models 
 4. Annotation Information 
 5. SBML Validation 
 6. Programmatic Interaction with CySBML 
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1. CySBML Installation & Basic Settings 
CySBML supports Cytoscape 2.8 or later and runs on all platforms supporting Cytoscape. Cyto-
scape has to be installed prior to the installation of CySBML. CySBML is available as manual 
download (latest version) or via the Cytoscape plugin manager (mayor releases). We recommend 
manual installation for access to the latest version of CySBML. 

Manual Installation 

[1] Download the latest CySBML version at http://sourceforge.net/projects/cysbml/. 

[2] Move the CySBML‐vX.XX.jar into the Cytoscape plugin directory located in the Cytoscape 
installation directory under plugins $CYTO_INSTALL/plugins/. This folder is normally located on 
Windows Systems at C:\Program Files\Cytoscape_vX.X.X\plugins\ on Mac OS X at 
/Applications/Cytoscape_vX.X.X/plugins/. 

Please replace the version number in the path name (_vX.X.X) with the version of your local Cyto-
scape installation. At the time of writing the most recent version of Cytoscape is 2.8.2 

[3] Remove the core SBMLReader 

sbml‐reader‐2.8.*‐jar‐with‐dependencies.jar from the plugin folder. 

The plugin is loaded and installed during the next Cytoscape startup. 

The SBMLReader has to be removed due to the registration process of plugins to certain file types. 
No conflicts arise after the SBMLReader is removed because CySBML provides the complete subset 
of SBML parsed by SBMLReader under identical node and edge attribute names. All plugins relying 
in any way on SBMLReader have access to the identical information in CySBML. 

Installation via the Plugin Manager 

CySBML is also available via the Cytoscape plugin manager 
 Plugins -> Manage Plugins 

[1] Search for 'CySBML', select CySBML in the menu and click the install button. 
[2] Remove the core SBMLReader plugin (see Manual Installation [3]) 
After restarting Cytoscape all features of CySBML are available. 

Update CySBML 

To update to the current version of CySBML replace the CySBML-vX.XX.jar from the Cytoscape 
plugin folder with the new version. 

Uninstall CySBML 

To uninstall CySBML remove the CySBML-vX.XX.jar from the Cytoscape plugin folder. 

Proxy Settings 

CySBML loads BioModels and the MIRIAM information via web services and performs the SBML 
validation via an online validator. To use these features an internet connection is necessary. 
CySBML uses the Cytoscape proxy settings for the connection which can be configured in 
Cytoscape via the Edit menu. 
 Edit -> Preferences -> Proxy Server 

The connection settings are tested after the changes have been applied. 
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2. CySBML Interface 
The main functionality of CySBML is accessible via the Cytoscape menu bar in the top region of 
the Cytoscape window 

 

  

 

  
SBML Import Load SBML files via the File Import Dialogue. To import multiple files 

select multiple files. 

  
BioModel 
Import 

SBML files from BioModels can be loaded via the BioModel Import 
Dialogue. 

  
SBML 
Validation 

Imported SBML files can be validated against the SBML specification. 
Select the SBML network to validate and click the validation icon. 

  
Hide/Show 
CySBML Panel 

Changes the visibility of the CySBML Panel. Initially the CySBML 
Panel is hidden and only opened after loading of SBML models. 

  
Help CySBML tutorial and help system. 

 

CySBML Panel 

The CySBML panel is opened after the import of SBML files in the Cytoscape results panel. If 
needed the visibility of the CySBML panel can be changed via the Hide/Show button. Clicking the 
hide show button without any loaded SBML models provides basic information about CySBML. 
When SBML models have been imported the CySBML panels displays the annotation information of 
selected network nodes in the SBML network and the SBML document structure. 
 
The CySBML panel is the main area of information providing access to the semantic information 
within the SBML models via web links and giving overview over the SBML document structure. To 
access the annotation information click on the web links which are opened in a separate browser 
window. 
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Figure 1: CySBML Panel after loading of SBML models and selecting of network nodes. In the
shown example the glycolysis model of Pritchard & Kell (BIOMD0000000172) has been imported via
the BioModel Import Dialogue (see Import of SBML Models) and the node for the reaction PGI
(phosphoglucose isomerase) has been selected. At the top of the CySBML panel access to the tree
of SBML compartments, species and reactions is provided reflecting the main elements in the
SBML document. Selection of nodes in the species and reaction list select the corresponding
nodes in the network view of the network. In the lower part of the CySBML panel the annotation
information for the selected node is shown. 
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3. Import of SBML models 
SBML models can be imported either from local SBML files or from BioModels.net. 

Import local SBML files 

  
SBML Import Load SBML files via the File Import Dialogue. To import multiple files 

select multiple files. Same functionality as  

Click on the SBML Import icon or use the Cytoscape File Importer 
 File -> Import -> Network (Multiple File Types) and select the files to import 

 

Figure 2: Multiple SBML models can be imported at once. In the example the first 5 curated
models from BioModels.net are selected.The selected models are loaded in Cytoscape and an
automatic network view is generated (in the example view of the first 5 curated models of
BioModels.net). SBML information is available as Cytoscape node and edge attributes. 
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Import Models from BioModels 

  
BioModel 
Import 

SBML files from BioModels can be loaded via the BioModel Import 
Dialogue. 

To import models from BioModels.net into Cytoscape open the BioModel Import Dialog accessible 
via the menu bar. Models can be searched via multiple criteria, namely, by model name, person, 
publication (pubmed id or publication abstract), ChEBI (id or name) or UniProt (id or name). The 
search is performed via web service requests and depending on the complexity of the search 
query can take some time. 
 

Figure 3: BioModel Import Dialoq with search results for the search query name=glycolysis.
Access to SBML models fitting the search query is provided via the results lists of models. To
import models, select the models and click load selected. In the example the first three models
fitting the search criteria have been selected. 
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4. Annotation information 
MIRIAM and SBO SBML annotations are accessible via the CySBML Panel. 

 

 

Figure 4: In the example the glycolysis model of Pritchard & Kell (BIOMD0000000172) has been
imported via the BioModel Import Dialog (see Import of SBML Models) and the node for the
species pyruvate has been selected. The SBML annotation information is provided in the CySBML
Panel to the right of the network view. Clicking on the web links opens the respective resources. 

Figure 5: Web link to
ChEBI opened in the
browser after clicking the
annotation information in
the CySBML Panel (see
http://www.ebi.ac.uk/ch
ebi/searchId.do?chebiId
=CHEBI%3A15361). 
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5. SBML Validation 
Imported SBML models can be validated against the SBML specification. To select an imported 
SBML model select the network to validate and click the SBML validation icon in the menu bar. 

  
SBML 
Validation 

Imported SBML files can be validated. Select the SBML network to 
validate and click the validation icon. 

 
The validation is performed online which can take a few seconds. The validation results are 
presented in the Validation Window. The error messages can be filtered with respect to the 
severity of the SBML error belonging to the categories INFO, WARNING, ERROR, FATAL, and ALL. On 
default the categories FATAL and ERROR are selected. 
 

Figure 6: In the example the glycolysis model of Pritchard & Kell
(BIOMD0000000172) has been validated and ALL error messages are shown. 
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6. Programmatic interaction with CySBML 
CySBML integrates seamlessly with Cytoscape Core and other Cytoscape plugins and tools by 
making SBML information available via SBML species and reaction attributes as node and edge 
attributes under defined names (definitions provided in the CySBMLConstants class, see Example 3 
for interaction with NetworkAnalyzer). To work with these attributes import the CySBMLConstants 
class in your application and use the defined Strings to interact with the attributes. For instance, 
the type of node is defined in the node attribute ATT_TYPE with the possible values defined as 
NODETYPE_* having the values of either species, r, qSpecies, or qTransition (see Example 1 for 
usage of the CySBMLConstants class to access SBML information). 
 
package cysbml; 
public class CySBMLConstants { 
  public static final String ATT_ID = "sbml id"; 
  public static final String ATT_TYPE = "sbml type"; 
  public static final String ATT_METAID = "sbml metaId"; 
  public static final String ATT_NAME = "sbml name"; 
  public static final String ATT_COMPARTMENT = "sbml compartment"; 
  public static final String ATT_INITIAL_CONCENTRATION = "sbml initial concentration"; 
  public static final String ATT_INITIAL_AMOUNT = "sbml initial amount"; 
  public static final String ATT_CHARGE = "sbml charge"; 
  public static final String ATT_SBOTERM = "sbml sbo"; 
  public static final String ATT_CONSTANT = "sbml constant"; 
  public static final String ATT_BOUNDARY_CONDITION = "sbml boundary condition"; 
  public static final String ATT_REVERSIBLE = "sbml reversible"; 
  public static final String ATT_STOICHIOMETRY = "sbml stoichiometry"; 
  public static final String ATT_MAX_LEVEL = "sbml max level"; 
  public static final String ATT_INITIAL_LEVEL = "sbml initial level"; 
   
  public static final String NODETYPE_REACTION = "reaction"; 
  public static final String NODETYPE_SPECIES = "species"; 
  public static final String NODETYPE_QUAL_SPECIES = "qSpecies"; 
  public static final String NODETYPE_QUAL_TRANSITION = "qTransition"; 
   
  public static final String EDGETYPE_REACTION_PRODUCT = "reaction‐product"; 
  public static final String EDGETYPE_REACTION_REACTANT = "reaction‐reactant"; 
  public static final String EDGETYPE_REACTION_MODIFIER = "reaction‐modifier"; 
  public static final String EDGETYPE_TRANSITION_INPUT = "transition‐input"; 
  public static final String EDGETYPE_TRANSITION_OUTPUT = "transition‐output"; 
  public static final String EDGETYPE_UNDEFINED = "undefined"; 
} 

 
Furthermore, it is possible to directly interact with the SBMLDocument for the current network via 
CySBMLNavigationPanel.getCurrentSBMLDocument(). Thereby, the full functionality of SBML is 
available via the JSBML library making information within the SBMLDocument accessible not 
providable via Cytoscape node and edge attributes (see Example 2 for accessing the current 
SBMLDocument). 

Example Plugin 1: selecting all reversible reactions in the SBML network. 

All example plugins are available as CySBMLExamples.jar with corresponding source code from the 
CySBML homepage at 

http://www.charite.de/sysbio/people/koenig/software/cysbml/CySBMLExamples‐v1.2.jar. 

After moving the CySBMLExamples‐v*.jar in the Cytoscape plugin folder the examples can be 
accessed via the Cytoscape plugin menu. Example Plugin 1 uses the CySBML attributes defined in 
CySBMLConstants. In this example all the reactions which are reversible in the SBMLDocument are 
selected. 



10 

 

Figure 7: The reversible reactions have been programmatically selected utilizing the attribute
information defined in CySBMLConstants. 
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 import Cyto¬scape.CyNetwork; 
  import Cyto¬scape.CyNode; 
  import Cyto¬scape.Cyto¬scape; 
  import cysbml.CySBMLConstants; 

  public void selectReversibleReactionNodes(){ 
    CyNetwork network = Cyto¬scape.getCurrentNetwork(); 
    network.unselectAllNodes(); 
    Collection<CyNode> reversibleReactionNodes = getReversibleReactionNodes(); 
    network.setSelectedNodeState(reversibleReactionNodes, true);     
    Cyto¬scape.getCurrentNetworkView().updateView(); 
     
    String text = String.format("%s reversible reactions", reversibleReactionNodes.size()); 
    JOptionPane.showMessageDialog(Cyto¬scape.getDesktop(), text, 
        "CySBML Example ‐ Select Reversible Reactions", 
        JOptionPane.INFORMATION_MESSAGE); 
  } 

  private Collection<CyNode> getReversibleReactionNodes(){ 
    Collection<CyNode> rrNodes = new LinkedList<CyNode>(); 
    @SuppressWarnings("unchecked") 
    List<CyNode> nodes = Cyto¬scape.getCyNodesList(); 
    for (CyNode n : nodes){ 
      if (isReversibleReactionNode(n)){ 
        rrNodes.add(n); 
      } 
    } 
    return rrNodes; 
  } 
   
  private boolean isReversibleReactionNode(CyNode n){ 
    boolean result = false; 
    CyAttributes nodeAttributes = Cyto¬scape.getNodeAttributes(); 
    String id = n.getIdentifier(); 
     
    // Get the SBMLType  
    Object tmp = nodeAttributes.getAttribute(id, CySBMLConstants.ATT_TYPE); 
    if (tmp == null){ 
      return false; 
    } 
    String sbmlType = (String) tmp;  
     
    // Get the reversibility information 
    tmp = nodeAttributes.getAttribute(id, CySBMLConstants.ATT_REVERSIBLE); 
    if (tmp == null){ 
      return false; 
    } 
    boolean reversible = (Boolean) tmp; 
     
    // Test if the node is a reaction and reversible 
    if (sbmlType.equals(CySBMLConstants.NODETYPE_REACTION)  
        && reversible == true){ 
      result = true; 
    } 
    return result; 
  } 
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Example Plugin 2: access to the SBMLDocument 

It is possible to directly interact with the loaded JSBML SBMLDocument for the current network via 
CySBMLNavigationPanel.getCurrentSBMLDocument(). The full functionality of JSBML is available for 
the document: 

 import org.sbml.jsbml.Model; 
  import org.sbml.jsbml.SBMLDocument; 
  import cysbml.gui.CySBMLNavigationPanel; 

  public void displayReactionsInCurrentSBMLDocument(){ 

    // Get the current SBML document via Singleton instance of the navigatin panel 
    CySBMLNavigationPanel panel = CySBMLNavigationPanel.getInstance(); 
    SBMLDocument doc = panel.getCurrentSBMLDocument(); 
    // Work with the current SBML document 
    String text = null; 
    if (doc == null){ 
      text = "No SBML document available for current network"; 
    } else { 
      // Access to the SBMLDocument 
      Model model = doc.getModel(); 
      text = String.format("Current SBML document: id=%s", model.getId()); 
    } 
    JOptionPane.showMessageDialog(Cyto¬scape.getDesktop(), text, 
        "CySBML Current SBMLDocument", 
        JOptionPane.INFORMATION_MESSAGE); 
  } 
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Example 3 - Interaction with other Plugins 

Many Cytoscape plugins work out of the box with CySBML using the SBML node and edge attribute 
information thereby making many additional features accessible for the work with SBML files in 
Cytoscape. For instance, NetworkAnalyzer can be used to calculate and visualize topological 
network parameters for SBML files. 
 
Load the SBML network to analyse and open the network analyser via 
 Plugins -> Network Analysis -> Analyse Network 

 
 

Figure 8: Application of NetworkAnalyzer to the model of glycolysis from
Pritchard & Kell (BIOMD0000000172) with node size mapped to node degree, 
edge size mapped to EdgeBetweenness, and node color mapped to 
NeighborhoodConnectivity. Reaction node PGK selected with corresponding 
SBML annotation information in the CySBML panel. 


